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Speaker 1: Hi everyone, Kevin here. Today, we are going to learn how to use Power BI in just 10 minutes. All organizations have a tremendous amount of data, but what are the stories behind that data and what decisions should you make based on that data? Power BI can help us with this. We'll start with how you can import data into Power BI. Then we'll look at how you could build a data model and start to add some visuals and also filter your data. And finally, we'll look at how you can share out your reports and dashboards with others. Let's start with how you can get Power BI. To get Power BI, open up the Microsoft Store and up in the search field on top, search for Power BI. In the results, you'll see three different options. So which one should you get? First, we have Power BI, and this allows you to view and interact with existing reports. Here we have Power BI Desktop, and this gives you the full functionality to model your data and also to build reports. Lastly, we also have the Report Builder, and this has much of the functionality that you'll find in Desktop, but it's not quite as feature-rich. For this video, we're going to use the Desktop experience. Simply click on this, and right here you can click to install or open if you already have the app installed. When you launch Power BI for the first time, you'll see this initial splash screen. Over on the left-hand side, you can get data, and in a moment we'll do this. Right down below, you can also access recent data sources that you've used. Here you'll see any other Power BI reports that you might have worked on, and you can also navigate to other reports that you may have access to. Over on the right-hand side, you have all sorts of different learning resources that are well worth looking at. If you don't want to see this splash screen on launch, at the very bottom you can uncheck this box and this will no longer appear. For now, I'll close this window in the top right-hand corner. This drops us into the main report view in Power BI. Over on the left-hand side, here I can see that I am in the report view. Currently, we don't have any data in here yet. Luckily, it's very easy to get data in. Right here, we can add data to our report, or right up here on the Home tab on the ribbon, here we also have the option to import data. When I click on this Get Data drop-down, you'll see that there are all sorts of different sources that you can pull into Power BI. Chances are, if you have data, you'll be able to bring it in. For this video, I'm going to use data in an Excel workbook. If you'd like to follow along, I've included a link to this workbook down below in the description. I'll click on this. Here I see my workbook. I'll double click on this. This opens up the Navigator, and this will assist me with getting my data into Power BI. Here I see my Excel workbook name, and I see that it has two separate tables and two separate sheets. You can tell based on this icon here. I can click into one of these tables, and here I can preview the data. There is one table called Customers, and this has all of the customer information at the Kevin Cookie Company. Down below, I also have order data for orders here at the Kevin Cookie Company. Then we also have Sheets, but I only have the table on the sheet, so there's no other data. I'll select this table and this table. Down in the bottom right-hand corner, we have a few different options. We can load the data as is. That means that I don't want to make any changes to it. I'll basically bring it in as it looks right up above. Alternatively, we can also transform the data. Basically, make some modifications. Maybe we want to clean up the data before bringing it into Power BI. You might be wondering, well, why would you want to transform it here? Why not just update the original Excel sheet? In some cases, you won't have edit abilities with the original data. Let's say it's a database, or maybe someone else owns the spreadsheet. In this case, you could edit it before bringing it to Power BI. For now, I'll simply click on Load. Over on the right-hand side in the Data pane here, I can see that I've successfully imported these tables from my Excel workbook. Here, I have all of my orders and I have all of my customer information. Down below, you'll see all of the different columns that were contained in the table, or what we can also refer to as fields. Over on the left-hand side, let's now dig into the data by clicking on this button for the Data view. This drops us in the Data view, and here I can see all of the different customer data that's contained within the Customers table. Now, there is one issue I noticed. Here, we have a column for a country, and I say the United States for a few of these, but then here it says the US. Ideally, I should clean this up. I can also click into the Orders table, and here I can see all the different orders that we've had here at the Kevin Cookie Company. We've been shipping a lot of cookies. Right here, there's a column called Rush Shipment, and I don't need this for my analysis, so I think I need to go back and make a few refinements to this data here. Let's click back into the Report view, and although I loaded the data, I can still go back and transform the data. On the Home tab, over here under Queries, we can click on Transform Data, and then Transform Data. This opens up the Power Query Editor, and we can use Power Query to modify and also clean the data before bringing it into Power BI. One thing to note is this does not at all affect the original data source. Think of it as a middle layer between your original data and Power BI. Over on the left-hand side, I can see that there are two separate queries. Each one corresponds with one of the tables that we would like to bring in, and the first one is called Customers. Here, I can see all of the data contained within Customers, and if I scroll over, here I see that Country column with the inconsistent reference to the United States. I can right-click on the country, and here there's the option to Replace Values. I'll click on this, and I want to look for references to US, and I want to replace that with United States. I'll click on OK. Over on the right-hand side, here I can see a record of all of the different changes that I've made. One of the beautiful things is as you bring additional data in in the future, these same steps will apply to that new data. Over on the left-hand side under Queries, let's now click into Orders, and here's the column Rush Shipment. I don't need this for my analysis. I'll select this column, and up above, I can remove this column. Right over here, we see a category for Transform, and this has some of the most popular transformations. Up on top, I can also click into Transform here, and we see lots of different tools that you can use to modify and clean up your data. For now though, I'm happy with the way everything looks. I'll click on Home, and then Close and Apply, and select this option. Back in the main report view, on the left-hand side, let's now click into the Model view, and here I can see the data model. Here I see the two different tables, and I can also see that Power BI automatically detected the relationship between these two tables. The Customers table has a customer ID, and the Orders table also has a customer ID. If for whatever reason, Power BI did not detect the relationship, you can simply drag an item from one table over onto the other table, and that will establish a relationship between these tables. Let's now go back into the report view, and let's start building out a nice report. Back now within the report view, I want to pull together a report, and a report is simply a collection of different visualizations. Over here on the right-hand side, you can see all the different visualizations that you get with Power BI. I want to show cookies over time, and I think a line chart would work really well for that. To insert one of these visualizations, here I simply click on a line chart, and here it places a placeholder in my report. Over on the right-hand side, here I see all of my data that I brought in, and I want to show cookies shipped. Here in my Orders table, there's an option called Cookies Shipped. I can take this item, and I can drag it in, and I'll place it on the y-axis. So there it shows up right here, but I also want to show it over time. Over on the right-hand side in the Orders table, I also have the order date. I can press and hold on this, and I'll drag this into the x-axis, and once I place that, you'll see the line chart start taking shape. I can click on this handle, and I can drag it so it's larger. I could even reposition it in whatever spot I want. Right now it shows orders shipped by day, but it's a little hard to make sense of what's going on. When I click on this, down below I have these different options where I can drill up. So instead of viewing it on a daily basis, instead I can view it on a monthly and a yearly basis, and this now looks really nice. Over on the right-hand side, again under Visualizations, if I scroll down, I have different options. I can add a secondary y-axis. I can pull in a legend. If we go up to the top, here I can also format the visual. So here I have a few different options, and right up under General, here I can also adjust some of the different properties. For example, the title. Currently it says Some of Cookies Shipped. Maybe I just want it to say Cookies Shipped by Date. If we go down to, I can also adjust things like the text color, and let me go with this blue color. That matches the Kevin Cookie Company theme color. To exit out of this view, I will simply click on the report, and that brings me back to this base state. I want to add some additional visuals to this report, and I'd like to show the total revenue that we've earned here at the Kevin Cookie Company. Of course, I could come in here and I could choose one of these visuals, or I could simply go down to the data, and here I'll check Revenue, and this automatically inserts a bar chart. It makes a best guess for what visual would work well, but I can still modify this if I want. Over on the right-hand side, with this visual selected, here I'll select a card, and instead of showing a bar chart, it now shows a total revenue of $6 million. Like I've always said, there's a lot of money in the cookie business. I'd like to include one more visual that shows all of our customers here at the Kevin Cookie Company. Over on the right-hand side, I'll check the box next to Customer Name, and here it automatically inserts a table visualization. One of the really neat things is I can click on any one of these customer names. So let's say Acme Grocery Stores, and that automatically filters this line chart and this card. Remember, we connected these two separate tables, so here when I choose a customer name, it knows what revenue and also the cookie shipped associated with that customer name. That's pretty cool. I can also press the Ctrl key, and I can multi-select customers. So let's say I want to see the revenue for these three customers. It looks like it was $4 million. To turn off this filter, I simply click on the side of the visualization, and it goes away. This report is coming together nicely, but I may want to add some additional pages in the future, maybe for different views of the data. Down below, I could simply double-click, and I could rename the page that I'm currently on, and I could click on this plus icon to add additional pages. For now, though, I'd like to share this out with the team just to start getting some feedback from them. Up on the top ribbon, over on the right-hand side, there's the option to publish. Let's click on that. Before we can publish, we'll need to save changes. I'll click on Save. For the destination, I'll select My Workspace, and then click on Select. And look at that success. Right over here, we can now open this on the Power BI web service. And check that out. I now see my report on the Power BI web service. In the top left-hand corner, I can click on the File menu. I can embed this report on a SharePoint site, on a website. I could also generate a QR code that will lead people directly to this page. Up on top, I can also export directly to a PowerPoint. I can even embed live data. I could export a PDF. I could also share it. Here, I could type in an email address or copy a link. And over here, I could even place it directly in a Microsoft Teams chat. All right. Well, it took slightly longer than 10 minutes, but hopefully that gives you enough to start exploring and building that muscle in this fantastic analytics tool. To watch more videos like this one, please consider subscribing, and I'll see you in the next video.
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